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 Introduction and Overview 

Introduction and Overview 
The Medmont AT-20P Acuity Tester is a computerised chart system 
intended for testing the human visual function and acuity. The Medmont 
AT-20P Acuity Tester will also be referred to in this manual as the AT-
20P. The AT-20P is a medical device Classified as a Class I device 
according to 93/42 EEC. 

The primary function of the AT-20P is to provide the user with a 
mechanism to display letter charts and symbols on the Patient Display 
Monitor that is viewed by the patient from a fixed specified distance. The 
clinician uses these chart displays to determine the patient’s visual acuity. 
Secondary functions include contrast sensitivity testing, binocular vision 
testing and patient education. 

The controller for this PC software is a Smart Device application that is 
available for Apple iOS and Google Android devices. Gestures and key 
presses are sent via a Wi-Fi connection to the PC, which interprets these 
based on the current software state and sends images to both the Patient 
Display Monitor and back to the controller for display to the clinician on 
the controller display  

The image on the handheld display is not a copy of the image on the PC’s 
monitor, but provides a summary of the displayed content and typically 
includes additional information. Some touch gestures will call up menus, 
and these are displayed on the handheld but not on the PC screen.  

If the PC is configured with dual monitors, the software can be configured 
to display the AT-20P information on the second monitor and this becomes 
the Patient Display Monitor. 

Standard AT-20P Accessories 
• Red/Blue Colour Flipper 

• User Manual including installation Guide 

• AT-20P Control Panel Software on CD-ROM medium 

• AT-20P Smart Device Software (available online) 

• Monitor label, 2 port covers, Patient Environment label 
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Optional System Accessories 
• TR2450 – Medical Isolation Transformer, 500W, 230/240V Supply 
• TR1150-VAR-UL – Medical Isolation Transformer, 500W, 100/120V 

Supply. For use in North America the customer must supply their own 
UL/CSA compliant extension cords between the Isolation Transformer 
and the peripherals (e.g. PC, monitor) 

• Personal Computer (PC) 
• Monitor 
• RS232 COM Port insulation plug 
• Network Insulation plug 

 

The combined rating of the PC, Monitor and Peripherals 
must not exceed the rated power of the Isolation 
Transformer(s). Each of these accessories may be 
independently powered by their own Isolation 
Transformer that meets the required specification. 
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Power Connection 
A typical power connection between the various units is shown in Figure 
1. 

 
Figure 1. Typical Power Connection 

 

For the diagnosis, treatment or monitoring of a patient under 
medical supervision there are three area definitions: Patient 
Environment, Medically used room and Non-medically used 
room. Each area demands different electrical safety 
requirements for your system. Please make sure that your 
system is set up correctly in the right environment. 

 

When used in a Patient Environment, the PC and its Monitor 
must be powered via a protective isolation transformer, 
compliant to the governing medical standard IEC60601-1 or 
UL2601/CSA22.2#601-1 for North America only. A hospital 
grade power cord must be used to achieve reliable grounding. 
The Isolation Transformer must be certified either cULus or 
cCSAus for North America, or UL for US market or CSA for 
Canadian market or meet National Electrical Regulations. 

 

The operator of the Medical Room must ensure that the 
installed hardware complies with the requirements for 
medical electrical systems. Please consult a qualified 
electrician to verify permissible touch currents. 

Touch currents shall not exceed 100µA in normal condition 
or 500µA in single fault condition within the patient 
environment. 
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Warranty 
The AT-20P software has been designed with all due care and subjected to 
stringent testing before leaving our factory. The Medmont AT-20P 
software is guaranteed for 12 months from the date of purchase as 
evidenced by the invoice. During this warranty period Medmont or an 
authorised agent will replace or upgrade the software free of charge. Such 
fixes do not extend the warranty period. The warranty does not cover 
defects due to incorrect handling, installation or set up, non-compliance 
with the requirements for computer hardware and associated mains 
powered equipment as specified in the User Manual, unauthorised 
modifications, loss of income, or service and repair costs for components 
and associated equipment.  
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Important Notes 

Application 
The Medmont Acuity Tester Model AT-20P is a computerised chart 
system intended for use by Optometrists and Ophthalmologists in testing 
patient visual function.  

Explanation of Symbols and Labels 

 

Warning: In event of user error or equipment 
fault condition there may be a serious risk to 
health or life of patients or operator. 

 

Caution: In event of user error or equipment 
fault condition there may be a risk to the health 
of patients or operator, or product damage or 
loss may occur 

 Precaution 

 
Compliance with The EC Directive 93/42 EEC 
for medical devices 
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This label is found on the PC port 
insulation plugs. These plugs are for RS232 
and Network ports. These PC ports are to 
be covered if PC is used within the patient 
environment. 

 

This label is to be attached on a visible 
position to any EN/IEC 60950 compliant 
equipment used within the electro-medical 
system of the AT-20P. The patient 
environment comprises a 1.5m radius 
around the area in which the patient or 
some other person can touch parts of the 
medical system intentionally or 
unintentionally 

Monitor calibration label indicating the 
marked calibration periods 

Clinical Results 
This manual does not provide guidance on interpretation of clinical 
results. The operator must ensure that he or she has received appropriate 
medical training in such interpretation. For this reason Medmont cannot be 
held responsible for misdiagnosis of results. 

Accuracy and Calibration 
As part of the installation process the instrument has to be calibrated to the 
monitor and the chosen working distance. It is not Medmont’s 
responsibility to guarantee or police the calibration status of this 
instrument after delivery. To assure the instrument is calibrated, the user 
should perform a calibration every three months (attach monitor label on a 
visible location on the monitor and mark the preferred calibration 
intervals).  This is described in Display Monitor Setup section on page 27. 
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Medmont or their authorised agents can provide this service in return for a 
fee. 

Radiation 
The Smart Device emits radiation in the international 2.4GHz ISM band 
when communicating with a PC. The radiation level conforms to EN55022 
and FCC 2.1093, Radiofrequency radiation exposure evaluation: portable 
devices. The emitted electromagnetic emissions are at a safe level and do 
not cause any harm or interference with other devices. 

Interference 
Strong Electromagnetic interference from other unprotected devices may 
affect the performance or results of the Smart Device. If the use of such 
devices with high electromagnetic emissions cannot be avoided, do not use 
the AT-20P and this device simultaneously. 

Side Effects 
No undesired side effects to patient or operator or other persons are known 
when using this instrument under normal conditions and for the intended 
purpose.  

Electrical Safety of Medical Electrical System 

 

Use only PC and associated equipment compliant to 
EN/IEC60950. If PC and associated equipment is used 
within patient environment, power only from a medically 
approved isolation transformer e.g. Medmont TR2450 or 
TR1150-VAR-UL.  

 
Do not touch charging contacts on the Docking Station or 
Handheld Controller and the patient simultaneously 

 

To ensure electrical safety and compliance to medical 
standards use the power supply as specified at the end of 
the user manual only! 
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Grounding reliability can only be achieved when the 
equipment is connected to a receptacle marked “Hospital 
Only” or “Hospital Grade” 

Ensure that associated equipment has market approval and 
complies with national standards. 

The operator will need to review all operation and safety 
guidelines provided by the Smart Device manufacturer 
concerning the use and re-charging of the device. 

Material Safety 
Materials intended to come into surface contact with limited exposure with 
the patient: Red/Blue Colour Flipper. Material name: Polypropylene PP. 
This material is commonly used for these types of medical devices. 

Cleaning and Maintenance 

Ensure monitor screen is kept free of dust.  

Do not modify monitor settings as this may result in loss of 
calibration of the device. 

Classification 
As this device is used together with non-medical equipment (PC, Smart 
Device), the following conditions shall apply; 

• Protection against electrical shock: Class I 

• Protection against harmful ingress of water: none 

• Oxygen rich environment: not suitable 

• Mode of operation: continuous 

• Methods of sterilisation: none 
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Manual Organization 
In discussing the normal interaction between the software and those 
involved in a particular operation, test or test review, the manual uses the 
term Operator to refer to the clinician operating the equipment, and 
Patient to refer to the person undergoing the test. The terms User and 
Operator are equivalent. The terms smart device and handheld controller 
are used interchangeably to refer to the electronic device used by the 
operator to control the patient display. 

When referring to menu selection, the terminology File > Save means 
click on the File menu entry, then on the Save entry in the File menu. 
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Installation 
This section describes the installation of the Medmont AT-20P PC 
software. 

Recommended System Requirements 
When acquiring a PC for the Medmont AT-20P Acuity Tester, observe the 
minimum requirements as given below. 

Use only PC and associated equipment that has been 
certified to the Standard EN/IEC60950 (Information 
Technology Equipment) and the Standards for 
Electromagnetic Emissions CISPR22/EN55022.  

Do not use additional multiple socket outlets with this 
system. 

If used within the patient environment, power PC and 
associated equipment with a medically approved isolation 
transformer e.g. TR2450 or TR1150-VAR-UL. 

If used in patient environment, to avoid electrical shock, 
cover any open PC communication ports which have 
accessible live conductors with provided dummy plugs 

Only connect to accessories specified for this device 

Do not use the charger for the Smart Device within the 
patient environment 

Medmont recommends a computer system with the following operating 
system software and hardware devices: 

• Pentium™ processor-based personal computer, P4 2.8 GHz or 
Higher 

• Microsoft™ Windows™ 7 

• 4 GB RAM or more (2 GB minimum) 
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• VGA card supporting at least 24-bit colour and 128MB onboard 
memory. Video cards that share main memory are not 
recommended – For stereo viewing using shutter glasses, a 
compatible NVidia video card is required 

• 10GB of available hard-disk space 

• DVD-ROM drive (CD-ROM minimum) 

Faster processors and larger memory will improve system performance. The 
Medmont AT-20P Acuity Tester uses the Microsoft Windows .NET 
environment, the software cannot be installed on systems using the 
unsupported versions 95 and 98. 

Medmont recommend Microsoft™ Windows™ 7 or later as the operating 
system of choice.  

Connecting a Smart Device to an existing cabled network 
The AT-20P software communicates with the Smart Device via a Wi-Fi 
based network connection. There are many ways a Wi-Fi enabled network 
can be setup and a full discussion of these is beyond the scope of this manual. 
A simple Wi-Fi enabled network is described in the following diagram. 
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The diagram shows a standard cabled PC network with an attached 
Wireless Access Point for communicating with wireless devices. The AT-
20P software has been installed on one of these PC’s and the AT-20P 
Smart Device application is able to communicate with it via the established 
Wi-Fi connection.  

WARNING! It is strongly advised to seek 
the help of a specialized computer technician 
when setting up a Wireless Access Point on 
an existing cabled network. Failure to take 
sufficient security measures can expose your 
confidential patient information to theft. 

Installing the AT-20P PC Software 
In Windows Explorer or from the Start > Run menu, navigate to the CD-
ROM drive and double click the file Setup in the root directory to launch 
the Medmont Installation Manager.  

Where the system is set up for user login, you will be given the choice of 
installing just for yourself or for all users. By default the installation will 
be for everyone and you will need Administrator privileges, so re-logon 
before starting the installation. 

The Medmont AT-20P PC software requires a Microsoft .NET Framework 
environment to run. In addition, the .NET environment requires a version 
5.1 or higher of Microsoft Internet Explorer. 

Installing the AT-20P Smart Device application 
Both the Apple and Android Smart Devices require a small application to 
be downloaded and installed to connect with the AT-20P PC software. 
These applications are freely available from the devices respective App 
Stores. The App Store for Apple devices is called iTunes and can be access 
from the iTunes icon on the home screen of the device. You will be 
required to enter your iTunes account if it hasn’t already been entered. 
Android devices will use the Market application and will also require you 
to enter your Google account. 

Once you have accessed your respective App Store search for the term 
“Medmont” to locate the AT-20P Acuity Tester application. Download 
and install the app to your Smart Device 
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Licensing 
The AT-20P software can be evaluated for a period of 30 days. After 30 
days the software can continue to be used except with an increasing delay 
at start up (proportional to the number of days past 30). After 60 days the 
software will be locked out completely. 

A software licence can be purchased through Medmont or an authorised 
dealer. Please visit the following web page for your local dealer. 

http://www.medmont.com/contact.aspx 
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 System Installation 

System Installation 
The Medmont Installation Manager will now proceed to install the AT-20P 
software. The initial dialog is shown below. 

  

Click on the Next button to begin the installation. The following dialog 
allows you to specify where the software should be installed. Medmont 
suggest you leave this as the default. Where the system is set up for user 
login, you will also be given the choice of installing just for yourself or for 
all users. By default the installation will be for everyone and in this case 
you will need Administrator privileges. 
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Click the Next button to begin the installation. When it completes the final 
dialog is displayed. 

 

Click the Close button to conclude the AT-20P installation. 

You can start the AT-20P application by double-clicking on the desktop 
icon, or from the Start menu 
Start>Programs>Medmont>AT20P>AT20P. 
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System Setup 
The system will typically be set up in a medical practice. The Smart 
Device will usually be within the patient environment, while the PC and its 
monitor may not be. There are no electrical connections between the PC 
and the Smart Device. If the PC is to be used in the patient environment 
then an isolation transformer is required. 

Starting the AT-20P Application for the First Time 
Ensure that the Smart Device and the computer that is running the AT-20P 
software are connected via the same Wi-Fi network. Start the PC 
application via Start>Programs>Medmont>AT20P>AT20P or double 
clicking the icon on the desktop.  

The first time you run the AT-20P software the Installation Wizard will be 
run. This wizard will guide you through the important steps to calibrate the 
installation for your particular environment and display monitors. The 
steps involved are covered in detail in the section on Display Monitor 
Setup on page 27.  

When the calibration is done you should see the initial default screen 
displayed on the PC monitor. 

 
You may now start the AT-20P client application on your Smart Device. 
The first time you run this application it will ask you for the name of the 
server computer you wish to connect to. Enter the name of the computer 
where you installed the AT-20P PC software. Once the name has been 
entered press the Connect button. If this is successful you will see a screen 
similar to the one below displayed on your Smart Device. 
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The patient display will not show a cursor and normally it will not show 
the Windows taskbar either, even though you may have set this in the 
Windows Start>Settings. Both these settings are necessary for a clean 
display with no distractions. You can press the Windows key on the PC 
keyboard or if this is not present, the Ctrl-Esc combination to restore the 
task bar. 

Starting the AT-20P Application Normally 
Start by clicking on Start>Programs>Medmont>AT20P>AT20P icon or 
clicking the icon on the desktop to launch the PC application. When the 
PC application is ready the PC splash window will disappear. The AT-20P 
icon  will appear in the Windows task bar. The PC application is now 
ready to accept a connection from a Smart Device.  

Next, start the Smart Device application by clicking the AT20P icon on the 
Smart Device home screen. This will automatically attempt to connect to 
the PC application with the previous connection settings. If the connection 
is unsuccessful the connection settings screen will appear. Review the 
connection settings and reattempt the connection by pressing the Connect 
button. 

On a successful connection the display will be the default or whatever you 
have selected if you have programmed a start-up state (see the Program 
Key on page 24). 

The Smart Device is ready to use as soon as the display appears.  

Stopping the AT-20P Application 
You close the AT-20P application by clicking on the  icon in the task 
bar (or selecting the application with the Alt-Esc key combination), and 
then clicking on the Terminate button.  
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A Tour of the Smart Device Display 
The figure below shows the initial handheld display. It has a standard 
layout that consists of a Title bar, Test Display section, and a Status bar. 
These sections and others are described below. 

1. The name of the current test. 

2. A description of the current display state associated with the Up/Down 
swipes. 

3. A description of the current display state associated with the Left/Right 
swipes. 

4. A description of any additional states that is associated with the current 
display or test.  

The Test Display is used to provide a 
summarisation of the patient display screen, 
along with additional information for the 
operator such as the Snellen fractions shown 
here down the left hand side. 

In general the Status bar will display 
parameters that are associated with the 
particular test, while the Title bar will show 

the test name. Subsequent chapters will describe the screens associated 
with each test in detail, but the basic display layout is the same for all tests. 

The Smart Device Touch Interface 
The Smart Device touch interface provides complete control over the 
acuity tester. It is worth spending some time to become familiar with both 
the layout and functionality of this interface. 

• Swiping up, down, left and right 

• Tapping the display 

• Row of mode buttons along the bottom of the display. 

• OneTouch keypad 

The following discusses the function(s) of each of the above. 
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Swipes 
The Status bar of the handheld display includes an indication of what the 
effect of the gesture will be. For example, when displaying the acuity 
charts, the display shown below indicates that the current display is a 
Multiline Decreasing and that the Left and Right swipes will change this. It 
also shows that the acuity of the current display is 6/38 (20/125) and that 
the Up and Down swipes will change that. 

 

For example, performing the Down swipe will change the display to look 
like this: 

 

Performing the Right swipe from this display will change it to display a 
Single Line test that looks like this: 

 

For many displays, the image sequence will cycle through the pre-defined 
set and then begin the cycle all over again. For example, swiping Right 

will move the acuity chart set from Single Line to Single 
Letter to Columnar Decreasing to Multiline Decreasing and 
back to Single Line. However, for some displays the 
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sequence comes to a natural end, and recycling from the opposite end 
would be inappropriate. For example the acuity tests naturally stop at the 
6/6 (20/20) chart in the one direction and 6/120 (20/400) in the other. In 
these cases, as shown here, the up/down arrow symbol in the bottom line 
will change to indicate there are no more states associated with swiping 
down. 

In this situation, the next time you swipe Down the PC will sound a short 
tone as an aural indication that there are no further displays in this 
direction. Note that the tone will not sound when the last display is first 
reached, only when an attempt is made to move further in that direction. 
This design means you can move from end to end of a particular display 
sequence without any extraneous noises by observing the up/down display 
indicator. If the tone is not a distraction in your situation, you can use the 
aural indication as a limit indicator. 

Mode Buttons 
The Mode Buttons are the three 
buttons across the bottom of the 
display. They provide for 
supervisory functions rather than 
direct test control. Here we will examine each button in turn. 

Options Key 
The menu displayed on the handheld when this key is pressed depends on 
the current test. The menu entries provide for selections that affect the way 
that particular test is displayed or how it functions. Each entry is explained 
under the Test Options heading for each test in the AT-20P Tests section.  

Blank key 
This key can be used to blank the patient screen entirely to 
black. It has no effect on the handheld display other than to 
display a blank symbol in the Title bar as shown here. 

Menu Key 
Pressing this key provides access to both the test selections and various 
operating parameters for the handheld itself. Navigating within a menu 
uses the same navigation keys described earlier, where the Up and Down 
keys provide up and down selection, and the Display key executes the 
selection. For example, pressing the Menu key and then the Down key to 
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highlight the Fogging test shows the handheld display below. Now you can 
press the Display key to activate this selection. 

 

All of the tests accessible directly via the keyboard are also selectable from 
this menu. Additional tests that may be added in future software revisions 
will be available from this menu. 

Selecting the Global Options entry at the top of the menu and pressing the 
Display or Right key takes you to a new menu that provides for setting 
various parameters of the handheld itself, and these are explained below. 

 

Global Options 
These options change the handheld’s modes, the way it responds, and the 
effect of options over time. Use the Up/Down keys to move between the 
menu items, and the Left/Right keys to change the selection for that 
particular entry. Some entries will cycle through their options while others 
will more oppropriately halt at either end of the possible selections. 

Option Mode 
This menu entry changes the way the patient’s screen responds to changes 
you make in the test’s options via the respective handheld menus. The 
modes available are Immediate and Deferred. As an example, pressing 
the Options key during a test will display a menu on the handheld that will 
offer options for the current test. Pressing this key during an acuity test for 
instance will display the menu: 
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If you were running this test and had previously selected the Immediate 
mode, making any selection in the above Options menu would 
immediately make the corresponding change to the patient’s display. In 
most cases the default setting of Deferred is less distracting to the patient, 
where you can make any number of selections within the Options menu 
but the changes will only be shown to the patient when you finally press 
the Display key. 

Immediate mode can be very useful when you are first getting to know the 
instrument’s capabilities. 

Acuity Format 
The selections for displaying Snellen fractions are Logmar, Imperial, 
Metric, or Decimal format. For example, the unity acuity fraction is 
represented in these three number spaces as 0.0, 20/20, 6/6.0 and 1.0 
respectively. 

I-Bars Distance 
This setting defines the distance between the I-bars and the Acuity test 
single letter as a percentage of the letter’s height. The range is 20% to 
100%. Note that with the larger percentages and large letters, the bars may 
be off-screen. The bars will never be partially shown. 

Key Click 
This entry cycles between the handheld producing a keyclick when a key is 
pressed being either on or off. The default is that the keyclick is on. 

OneTouch keypad 
The OneTouch keypad provides quick access to all the charts and to some 
supervisory functions without requiring you to navigate through scrollable 
menus. 
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Random Key 
Use this key to change the algorithm used to generate the various letters 
used in the Acuity tests. In Preset Mode, the characters will always be 
exactly the same and in exactly the same order. In Random Mode, every 
time the Display key is pressed a new and completely random set of letters 
will be generated (see Excluded Words on page 63 for info on how 
offensive letter combinations are filtered). Note that The Random key is a 
toggle – pressing it once turns the random mode on, pressing it again turns 
random mode off. 

Program Key 
Use this key to save various configurations and associate them with the 
Function keys (F1, F2 and F3). The function keys provide for saving up to 
six preset test configurations. The first three are directly accessible by 
pressing the respective key, and pressing the 2nd F key must precede the 
second three. You can also configure the test that will run at startup and its 
initial state.  

There are five entries in the Program menu. We will deal with the first 
two entries together. 

Save Current Test settings and Save Settings for ALL tests 
The Status bar for both these selections will show Press the Fx to Program, 
where the x can be either 1, 2 or 3. 

To use this function, first select a test, move it to a particular display state 
via the direction keys and possibly the test options via the Options key, 
and then press the Program key. If you select the Save Current Test 
settings option, when you press the chosen Fx key the application will 
henceforth permanently associate this test and its state with that function 
key. You can save an additional three test presets if you press the 2nd F key 
prior to the Fx key,. 

If you had selected the Save Settings for ALL tests option, the current 
settings for all tests will be saved against that function key. Pressing this 
key subsequently will restore all tests to that saved state. 

Clear Function Key Settings 
The Status bar for this selection will show Press the Fx Key to Clear. 
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The test states saved with the Save Current Test settings and Save Settings for 
ALL tests settings against the selected Fx key can be cleared to the system 
default from this selection.  

Save Current Settings as Startup 
The Status bar for this selection will show Press the Display Key to Save. 

Normally, the AT-20P software will startup in the default configuration. 
Use this menu entry to save the current configuration and display state of 
all tests that you wish to see every time the application starts. 

Restore Default Startup Settings 
The status bar for this selection will show Press the Display Key to Clear. 

Use this menu entry to clear all tests to their default state at startup. 

2nd Function Key 
A number of the keys in the lower half of the keypad have dual use. These 
are highlighted in a blue colour. Pressing the 2nd F key will activate these 
keys to perform their second function.  

Action Keys 
The action keys provide shortcuts directly to the various tests. Pressing any 
of the top six keys will take you directly to that test. The display will be as 
you last left it (see Program Key on page 24) or the default. However, the 
Binocular test will always start with the red-blue bars at zero minutes 
offset. 

Pressing any of the Snellen fraction keys will 
take you directly to that Acuity test screen. 
What is displayed on the screen will depend on 
your last acuity selection. For example, if you 
had previously selected a Single Letter acuity 
display, then all of these keys will take you 
directly to a single letter display at their 
specified acuity. For all multi-line displays, the 
top line will display at the specified Snellen 
fraction. 

The four keys with blue writing are second 
function keys. To access these tests directly you 
must first press the 2nd F key in the top group 
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of three keys. 

The three function keys along the bottom are for saving the state of often 
used test configurations. Once saved, subsequently pressing that key will 
display the test exactly as it was saved. While there are only three keys, the 
2nd F key provides for saving up to six test configurations (see Program 
Key). 

Disconnecting the Smart Device from the AT-20P 
application 
The AT-20P software only allows a single Smart Device connection at a 
time. You may however, like to allow other clinicians access to the charts 
when you are not using them. To do this you will need to disconnect your 
Smart Device from the AT -20 PC software. In the case when you are still 
within Wi-Fi range this can be done manually. Otherwise, if your Smart 
Device goes outside Wi-Fi range it will be disconnected automatically.  

To disconnect manually you will need to navigate to the task menu. To do 
this touch the icon at the bottom right-hand corner of an Apple device; 
or press the menu button located underneath the main display of an 
Android device. In either case touch on the Disconnect button now 
displayed. 
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Display Monitor Setup 
It is very important that once the patient display monitor is set up and 
calibrated, that the various settings are not changed without repeating these 
setting and calibration sequences. The validity of tests based on contrast 
and Snellen fractions, and the ability to compare results for all tests, relies 
on these settings remaining constant. 

Settings such as the display monitor brightness and contrast and the other 
variable settings associated with older CRT monitors such as horizontal 
and vertical size, pincushion, trapezoid, etc, cannot be detected by the 
software and so maintaining the settings are the responsibility of the user. 

 

Medmont recommend that every Practice establish a 
program where these variables are tested at a regular time 
period. A suggested period is every 3 months. The 
techniques described below can be used for the 
dimensional settings, and the brightness settings can be 
verified by testing known subjects. 

Medmont recommend the normal adjustable controls on 
the patient monitor for brightness, contrast, etc, be 
protected physically, or by attaching the Medmont 
supplied signage to display a warning about inadvertent 
adjustment. A change in any of the monitor settings 
requires recalibration. 

Changing the patient display monitor will require these 
adjustments be applied to the new monitor. 

 

The AT-20P software is aware of changes to the current screen resolution 
when running, and continuously compares the current resolution against 
the calibration resolution at start up. If a change is detected it will alert you 
with a warning message and automatically run the calibration wizard. 

If this occurs unexpectedly you should make every effort to determine why 
before simply proceeding with the calibration. 
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Positioning the Display 
Realistically, the working distance between the patient and display monitor 
should be between 4 to 10 meters (13 to 33 feet). Much closer and the 
smaller Snellen sizes are likely to be illegible on most monitors, and the 
larger character sizes will be too big for most monitors at longer distances. 
Medmont recommend a distance close to 6 meters (about 20 feet), as the 
software/hardware is designed primarily for this distance. The required 
monitor screen size is somewhat dependant on this distance, as the height 
of a 6/120 character at 4 meters is about 116 millimetres, and at 8 meters is 
about 232 millimetres. Note that a 6/3 character at 3 metres is only 2 mm 
high! The same calculations in imperial give a 20/400 character height at 
13 feet of about 4.5 inches, and at 26 feet of about 9.1 inches. A 17” 
monitor would be suitable over most of the recommended distances. You 
could use a 15” monitor for the closer distances. 

You can mount the monitor on the wall behind the patient, either on a shelf 
or on a support arm such as a Pivotelli® arm, and view the monitor via a 
mirror on the opposite wall (preferably front-silvered to minimise 
distortion). The mounting height is typically about 1.5 to 2 meters (4.9 to 
6.6 feet). Position the mirror so that the image of the monitor appears 
straight ahead of the patient. 

Alternatively, you can mount the monitor directly in front of the patient if 
the room is large enough. 

Extension cables for the monitor are available if you need to extend the 
distance between the computer and monitor. However, make sure it is a 
high-quality, impedance-matched cable to minimise “ghosting” effects on 
the display. 

Calibrating the Monitor 
The following instructions detail how to setup and calibrate the dimensions 
of the patient monitor. This is a very important step as many tests display 
characters with a dimension that assumes a specific logMAR number, i.e. 
that a particular Snellen ratio subtends a particular vertical angle. The AT-
20P also requires the monitor brightness/contrast be calibrated for certain 
tests (see the section on Monitor Calibration on page 52 for the Contrast 
Threshold Test). 

The AT-20P provides a simple means for measuring the pixel size and 
aspect ratio of the patient monitor, and subsequently uses these 
measurements whenever displaying on this monitor. 
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Single Monitor Setup 
Verify that the Windows monitor setup specifies that the monitor displays 
colour in the True Colour mode. Click on Start>Settings>Control Panel 
to display the Control Panel and then double click on the Display icon to 
bring up the Display Properties dialog. Click on the Settings tab and 
ensure the Colours drop-down control is showing True Colour (32-bit) or 
True Colour (24-bit). 

The AT-20P software uses sophisticated anti-aliasing techniques to display 
characters. However, to reduce pixilation to a minimum, Medmont 
recommend a minimum patient screen resolution of 1024x768. For LCD 
and plasma displays, set the Windows screen resolution to match that of 
the display. 

Start the AT-20P application and turn on the handheld controller. When 
the connection is made, click on the AT-20P icon  in the task bar to 
display the AT-20P Control Panel. 

 

Click on the Screen Setup tab then click the Set/Calibrate Monitor 
button. This will show the dialog below. 
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Select the measurement units used in your practice. All the AT-20P 
controls will subsequently display in these units. The following discussion 
will assume you selected Metric units. Press the Next button. 

 

Carefully measure the distance between the monitor screen and where the 
patient’s eye position will be. Note that this is not the distance between the 
patient and the mirror in a mirrored system. Set the Viewing Distance to 
this measurement.  

Select whether you are using a mirror or not and whether you want the 
patient monitor to display automatically when the application is started.  

The Windows Monitor should be set to 1 for this case. See Dual Monitor 
Setup on page 29 for a two-monitor installation. Click on the Next button 
to see the following screen. 
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Carefully measure the size of the black rectangle behind the dialogs. The 
measurement is fairly easy on a flat panel LCD monitor, but on a CRT 
monitor, remembers the glass is very thick and so ensure you compensate 
for parallax error by aligning your eye with an imaginary line from the 
respective rectangle edge back to the patient’s eye position. Enter these 
two measurements into the respective Width and Height controls. Click 
the Finish button to save these settings when you are satisfied with the 
measurements. 

Dual Monitor Setup 
Windows XP and subsequent versions provide for using dual monitors. 
This is an ideal situation for the AT-20P as the patient monitor can be 
quite separate from the normal monitor the PC uses and can be dedicated 
to the AT-20P patient display.  

Verify in the Settings tab of the Windows Display Properties dialog that 
the dual monitor setup specifies that the patient monitor(s) use True 
Colour (32 bit) or True Colour (24 bit) in the Colours control.  

The AT-20P software uses sophisticated anti-aliasing techniques to display 
characters. However, to reduce pixilation to a minimum, Medmont 
recommend a minimum patient screen resolution of 1024x768. For LCD 
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and plasma displays, set the Windows screen resolution to match that of 
the display. While not necessary, it also makes sense to have both monitors 
display at the same resolution and with the same colour depth. 

Finally, while still in the Settings tab, click on the second monitor icon 
and ensure the Extend my Windows desktop onto this monitor checkbox is 
checked as shown here. 

 

You can check this is all working by starting an application (Explorer, 
Paint, etc) and dragging them between the two monitors. 

Start the AT-20P application and turn on the handheld controller. When 
the connection is made, click on the AT-20P icon  in the task bar to 
bring up the AT-20P Control Panel. Click on the Screen Setup tab and 
click the Set/Calibrate Monitor button. This will show the dialog below. 
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Select the measurement units used in your practice. All the AT-20P 
controls will subsequently display in these units. The following will 
assume you selected Metric units. Press the Next button. 

 

Carefully measure the distance between the patient monitor screen and 
where their eye position will be. Note that this is not the distance between 
the patient and the mirror in a mirrored system. Set the Viewing Distance 
to this measurement.  

Select whether you are using a mirror or not and whether you want the 
patient monitor to display automatically when the application is started.  

Set the Windows Monitor control from 1 to 2. Click on the Next button 
and the black calibration rectangle should transfer from the primary to the 
secondary (patient) monitor, showing a display similar to the following.  
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Carefully measure the size of the black rectangle on the patient monitor. 
The measurement is fairly easy on a flat panel LCD monitor, but on a CRT 
monitor, remembers the glass is very thick and so ensure you compensate 
for parallax error by aligning your eye with an imaginary line from the 
respective rectangle edge back to the patient’s eye position. Enter these 
two measurements into the respective Width and Height controls. Click 
the Finish button to save these settings when you are satisfied with the 
measurements. 

Stereo Viewing 
In addition to Anaglyphic (Colour Separation) Stereo Viewing, it is now 
also possible to enable Stereo Viewing using a Stereo Interlaced Monitor 
or Shutter Glasses with an NVidia Stereo Driver (requires a compatible 
NVidia graphics card). Shutter glasses require a high refresh rate and 
therefore cannot be used with LCD monitors. 

These stereo viewing options are used for testing patient binocular vision. 
Press the Binoc button on your handset repeatedly to cycle through the 
available binocular vision tests.  

Configuring Stereo Viewing 
The stereo viewing mode is now configured by the AT20P Installation 
Wizard and can also be set from the Set/Calibrate Monitor dialog from 
within the AT20P Control Panel, under the Screen Setup tab: 
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Three variants of the stereo display are available from the drop down 
menu: 

1. The first, Anaglyphic, uses a Duo-Chrome display on a standard CRT 
or LCD monitor and red/blue anaglyphic flippers. 

2. The second, Interlaced Stereo Monitor, uses a stereo LCD monitor and 
polarised goggles. 

3. The third, NVidia Stereo Driver, uses a CRT monitor and shutter 
goggles. Medmont recommends the use of wireless shutter goggles as 
other models may not conform to the safety standards for medical 
electrical systems. 

Please note the requirements to the Electrical Safety of Medical Electrical 
System on page 8. 

After selecting your stereo viewing mode and clicking Next, you will be 
prompted to test the stereo image separation by way of a simple 
observation test. Ensure that, with the opposite eye closed, the Left and 
Right text prompts are visible independently of each other. With both eyes 
open, they should both be visible (the supplied Red/Blue Anaglyphic 
Flippers or Shutter Glasses are required for this test). Confirm your 
success on the prompt following to complete the Stereo Setup. 

You are now ready to start using your desired stereo viewing mode. 
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Functional Tests 
The available tests on the AT-20P are: 

1. Acuity 

2. Cross Cylinder 

3. Duo-Chrome 

4. Duo-Chrome Acuity 

5. Fogging 

6. Binocular Disparity 

7. Binocular Acuity 

8. Worth Four 

9. Gratings 

10. Contrast Threshold 

11. Acuity Staircase 

12. Charts 

13. Fixation Targets 

The following sections describe the options available for these tests. They 
assume you have previously selected the respective test and have then 
pressed the Options key (see the Mode  on page 21). 
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Acuity Test 
The Acuity test provides the ability to display a range of standard visual 
acuity charts with a variety of Optotypes (or character sets). 

Swiping Up/Down changes the size of the displayed symbols. 

Tapping switches between Random and Preset mode.  In Random mode 
each time the screen it tapped or the users swipes Up/Down a new set of 
randomly generated symbols are displayed. 

Options 
Pressing the Option key displays a menu on the handheld that allows you 
to configure the acuity chart parameters.  

 

There are six options available from this menu. 

Optotype Option 
This menu entry provides for selecting the current displayed symbol(s) 
from the standard set of acuity symbols: 

Snellen, 
Snellen HOTVX, 
Snellen HOTV, 
Illiterate E, 
Landolt C, 
Lea, 
Numeric and 
ETDRS. 

Examples of each with the display set to Single Line mode are shown 
here. 
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Unless the system is in Immediate Mode, the display will remain as it was 
until the Display key is pressed, at which time both displays will reflect 
the current acuity settings but with the new symbol set. 

Acuity Mode Option 
This menu entry provides for selecting the acuity mode. The options 
available are: 

Columnar Decreasing,  
Multiline Decreasing, 
Single Line and,  
Single Letter 

These options are also directly available by swiping Left or Right. 

I-Bars Option 
This allows for turning the single letter I-bars either on or off to simulate 
the effects of crowding. Note that the I-bar distance from the letter is a 
global setting and set from the menu presented via the Menu>Global 
Options key strokes. 

Contrast Option 
The Acuity test characters can be displayed at various levels of contrast 
with the white display background. The contrast levels range from 10%, 
which should make them invisible to almost everyone, to 100% for 
maximum contrast. 

 Medmont Acuity Tester User Manual 38



 Acuity Test 

Acuity Level Option 
This sets the acuity level, and ranges from a metric 6/3 up to 6/120 
(depending on the size and resolution of the monitor). The acuity level can 
also be directly changed from the main acuity screen by swiping Up or 
Down.  

Chart Type Option 
This determines the steps in acuity size displayed and the spacing between 
lines and letters. There are four options: 

Logmar,  
US-Snellen, 
UK-Snellen,  
EU-Snellen, 
ETDRS 

The Logmar chart has been designed such that the acuity levels are based 
on logarithmic steps that correspond to physiologically perceivable 
changes in symbol size.  The US, UK and EU Snellen charts provide 
standard Snellen charts based on traditional imperial, metric and decimal 
steps respectively.  These charts may be useful if a particular traditional 
Snellen acuity level or chart must be used for a given test. The use of Early 
Treatment Diabetic Retinopathy (ETDRS) charts implies adherence to a 
standardized testing procedure basically requiring the patient to read all 
letters beginning from the top row, with the examiner scoring acuity letter-
by-letter rather than line-by-line. The steps sizes for each of the available 
charts are given in the following tables: 
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logMAR Decimal Ratio Imperial Ratio (20/x) Metric Ratio (6/x) 
-0.3 2.0 10 3.0 
-0.2 1.58 13 3.8 
-0.1 1.26 16 4.8 
0.0 1.00 20 6.0 
0.1 0.79 25 7.6 
0.2 0.63 32 9.5 
0.3 0.50 40 12 
0.4 0.40 50 15 
0.5 0.32 63 19 
0.6 0.25 80 24 
0.7 0.20 100 30 
0.8 0.16 126 38 
0.9 0.13 159 48 
1.0 0.10 200 60 
1.1 0.08 252 76 
1.2 0.06 317 95 
1.3 0.05 399 120 

logMAR Chart Steps and representation in different formats 

US-Snellen Decimal Ratio 
20/12 1.6667 
20/15 1.3333 
20/20 1.0 
20/25 0.8 
20/30 0.6667 
20/40 0.5 
20/50 0.4 
20/60 0.3333 
20/70 0.28571 
20/80 0.25 

20/100 0.20 
20/125 0.16 
20/160 0.125 
20/200 0.10 
20/250 0.08 
20/320 0.0625 
20/400 0.05 

US-Snellen Chart Steps 
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UK-
Snellen Decimal Ratio 

6/4 1.5 
6/5 1.2 
6/6 1.0 
6/8 0.75 
6/9 0.66667 

6/12 0.5 
6/15 0.4 
6/18 0.3333 
6/24 0.25 
6/30 0.2 
6/36 0.16667 
6/48 0.125 
6/60 0.1 
6/76 0.0789 
6/95 0.0631 
6/120 0.05 

UK-Snellen Chart Steps 

 
EU-

Snellen Decimal Ratio 

1.5 1.5 
1.2 1.2 
1.0 1.0 
0.9 0.9 
0.8 0.8 
0.7 0.7 
0.6 0.6 
0.5 0.5 
0.4 0.4 
0.3 0.3 
0.2 0.2 

0.15 0.15 
0.1 0.1 

0.05 0.05 

EU-Snellen Chart Steps 
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Cross Cylinder Test 
The Cross Cylinder test provides for the display of a range of fixed Cross 
Cylinder targets. 

Options 
The Type is the only option available from the Option menu. However 
there are a limited number of sizes available by swiping Up or Down. 

Type Option 
The options are Circles, Hexagon and Cross. The handheld screens for 
the first two are shown below. 

 

The cross is intended to work with the fixed x-cyl auxiliary lenses in 
phoropters that are +0.25/-0.5 axis vertical, so that essentially this is a 
combination of +cyl axis horizontal and –cyl axis vertical. 

 
Selecting these options is also directly available via the Left/Right keys. A 
limited number of sizes are available by swiping Up or Down. 
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Duo-Chrome Test 
The Duo-Chrome test provides for the display of a range of fixed Duo-
Chromatic targets. 

Options 
The Type is the only option available from the Option menu. However 
there are a limited number of sizes available by swiping Up or Down. 

Type Option 
The options are Letters and Circles. The corresponding two graphics are 
shown below. 

 

In each case the graphic is centred on the patient’s display and with an all 
black background. These options are also directly available by swiping 
Left or Right. A limited number of sizes are available by swiping Up or 
Down. 

Although not normally necessary, the default red and green backgrounds 
can be individually adjusted to any colour. See Setting Test Colours for 
Duo-Chrome and Duo-Chrome Acuity Tests on Page 64. 
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Duo-Chrome Acuity Test 
The Duo-Chrome Acuity test allows display of standard acuity charts over 
a split Duo-Chrome background. Press the Duo-C button twice on your 
handset to display the Duo-Chrome Acuity test.  

 

The two halves of the Acuity Chart are displayed separately on a red and 
green background, as shown above. A limited number of sizes are available 
by swiping Up or Down. The Random letter mode can be used as per Acuity 
mode.  

Options 
The Options for Duo-Chrome acuity are Optotype, Contrast, Acuity Level 
and Chart Type. These options work as per the Acuity Test Options on Page 
37. 

Although not normally necessary, the default red and green backgrounds can 
be individually adjusted to any colour. See Setting Test Colours for Duo-
Chrome and Duo-Chrome Acuity Tests on Page 64. 
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Fogging Test 
The Fogging test provides for display of various fogging indicators and 
allows the operator to set the angle of the fogging indicator.  

Options 
There are three options available. 

Type Option 
The options are Fogging, Fogging L, and Fogging V. The corresponding 
three graphics at the default 0° angle are shown below. These options are 
also directly available by swiping Left or Right. 

 

V Increment Option 
This option sets the rotational increment for the V and L graphics. The 
available settings are 2.5° and 5°, and apply to the angular steps by which 
these graphics can be rotated.  

The Up key rotates the entire V and L graphic or the fogging pointer 
clockwise, and the Down key anti-clockwise. The graphic selection is also 
available from the fogging display by swiping Left or Right. 

Display Offset Option 
An offset of 0° (the default) displays 0° for the three initial display 
positions above. Pressing the Up key increases the displayed angle to 90° 
vertical and on through to 180°. Selecting the 90° offset option changes 
this so that the initial positions above indicate 90°. Swiping Up increases 
the displayed angle to 180° vertical. Continuing to swipe Up moves into 
the second quadrant which starts from 0° and increases to 90° again. 
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Binocular Disparity Test 
The Binocular Disparity test allows measurement of horizontal and vertical 
binocular disparities. Press the Binoc key until the Binocular Disparity 
Test is displayed.  

The test displays two indicator bars separated by a set disparity angle.  One 
indicator bar is displayed to the left eye only, the other to the right eye 
only.   The operator changes the disparity angle (measured in degrees) 
until the patient perceives that the two indicators are aligned.   The stereo 
viewing mechanism can be configured using the Control Panel (see Page 
34). 

Options 
There is only one option available: 

Type Option 
The selections available are Horizontal Disparity and Vertical Disparity. 
Horizontal Disparity will display two aligned vertical lines which can be 
offset to test patient binocular disparity. Vertical Disparity will display 
two aligned horizontal lines which can be offset to test patient disparity: 

    

ove between screens. For example, you could switch between 
rizontal and Vertical and the bar offset will remain at the p

 
Horizontal Disparity Display        Vertical Disparity Display     

In Horizontal Disparity swiping Up moves the display in the exotropic 
direction, and swiping Down moves the display in the esotropic direction.  
In Vertical Disparity swiping Up moves the display in the left direction, 
and swiping Down moves in the right direction. 

For these tests, the horizontal or vertical bars will remember their offset if 
you m
Ho revious 



 Binocular Disparity Test 
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be zero when the test is started again. 

s 



Binocular Acuity Test 

Binocular Acuity Test 
The Binocular Acuity test allows display of standard acuity charts split 
down the centre between left and right eyes.  Press the Binoc key until the 
Binocular Acuity Test is displayed.  

The left half of the chart is displayed to the left eye only and the right half 
to the right eye only. The stereo viewing mechanism can be configured 
using the Control Panel (see Page 34).   

A limited number of sizes are available by swiping Up or Down. The 
Random letter mode can be used as per Acuity mode.  

 
Binocular Acuity Patient Display 

Options 
The Options for Binocular Acuity are Optotype, Contrast, Acuity Level 
and Chart Type. These options function as per the Acuity Test on page 
37. 
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Worth Four Test 
The Worth Four Test provides a quick measurement of binocular 
perception.   Press the Binoc key until the Worth Four Test is displayed.  

Four targets are displayed.  The top target is displayed to the right eye 
only.  The middle two targets are displayed to the left eye only.   The 
bottom target is displayed to both eyes.   The patient indicates how many 
dots they can see.   Four dots indicate normal binocular function.   Three 
dots indicate left eye dominance. Two dots indicate right eye dominance. 

The stereo viewing mechanism can be configured using the Control Panel 
(see Page 34).   

 

 
Worth Four Patient Display 
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Gratings Test 
The Gratings test allows display of various gratings for testing visual 
acuity.  The patient indicates whether the displayed grating is vertical or 
slopes to the right or left.  

Tapping the Smart Device screen will randomly select either Left, Vertical, 
or Right slopes. Swiping Up will also randomly select from the Left, 
Vertical or Right slopes, but decreasing the spatial frequency each time. 
Swiping Down will randomly select from the Left, Vertical or Right slopes 
but increasing the spatial frequency each time. Swiping Left will cycle the 
bars counter-clockwise, and swiping Right will cycle clockwise.  

Options 
There are four selection options available. 

Grating Type Option 
The available settings are Square and Sine Wave, and shown below are 
the two patient displays in that order. The Square and Sine names describe 
the function that governs the grey scale transition from bar to bar – Square 
being a square wave with an abrupt transition from white to black, and 
Sine using a sine function to control the transition from full white to full 
black and consequently blurring the edges. 

 

Grating Angle Option 
The Grating Angle option describes the angle deviation from the 
horizontal. The range is 10° to 80° in 10° steps. 

Direction Option 
The Direction option allows you to set Left, Vertical or Right, and 
describes the slope the gratings will take. 
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Acuity Level Option 
This option allows you to set the Acuity Level, or spatial frequency of the 
bars.  

Note that these options allow you to control the patient display directly 
where necessary, whereas changing acuity from the test will randomly 
switch between left, right and vertical as you change acuity. 
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Contrast Threshold Test 
The Contrast Threshold test momentarily displays a single letter from the 
standard optotype selection, with or without I-bars, and at an operator 
selectable size. The operator can select the duration during which the letter 
is displayed. The default is 500 milliseconds with the selectable range from 
50 to 2000 milliseconds in 50 millisecond increments. The letter is 
presented to the patient and he or she is asked whether they recognised the 
letter. The letter and its current contrast setting are displayed on the 
handheld screen along with some statistical data. 

If the patient recognises the letter correctly then the operator must swipe 
Right, if not then swipe Left. Based on this response the software will 
adjust the contrast and present a different letter at that new contrast setting. 

The contrast threshold is a dimensionless number with a range of 0-100 
that is a measure of the patient’s contrast threshold. The number that is 
considered normal is dependant on your particular monitor and room 
lighting conditions. 

Monitor Calibration 
For this test to be consistently meaningful, it is very important that the 
room lighting conditions and the brightness and contrast settings of the 
monitor be constant from test to test. There is no way for the software to 
monitor this in the background as it does for the screen resolution (see 
Calibrating the Monitor on page 28), so these settings are something you 
must set up and control for your particular practice. 

Verify that the PC display adapter is set for 
24/32-bit colour (16.7 million colours). 

After standardising the patient monitor brightness and contrast settings, 
and establishing a standard room lighting, perform a series of tests on 
persons with normal vision to establish a normal contrast threshold value 
that applies to your particular equipment and conditions. A person with an 
abnormal contrast threshold will record a higher threshold value than this 
figure. 
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 Contrast Threshold Test 

Performing the Test 
The initial screen below allows a pre-test setup. 

 

The Optotype selection is the standard set, although as the patient must 
“recognise” the letter, perhaps only a subset of the types are applicable. 
The Acuity level, Exposure time, and I-bars may be set as desired for the 
intent of the test. Press the Display key to start the test. 

The initial patient screen displays a single letter for the specified time and 
the handheld display presents an initial test state. 

 

The Letter is the letter that was displayed to the patient. The Contrast was 
the contrast number of that initial letter.  

At random times during the test, the software will display a letter at a 20% 
higher contrast figure than the current mean contrast (i.e. a contrast that, 
based on past letters that were seen, should be easily seen). The False 
Negatives ratio shows the number of presentations that were presented at 
this higher contrast figure on the right and the number of those that the 
patient responded to in the negative, i.e. did not see, on the left. The left 
number should be zero if the patient is responding correctly. This figure is 
intended to provide a level of confidence that the patient understands the 
test and is responding appropriately. 
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Contrast Threshold Test 

The 1% and 99% Levels define the probability boundaries such that 1% of 
the population is expected to be below the 1% figure, and another 1% 
above the 99% figure. Of course this means that 98% of the population is 
expected to be between these boundaries. In this starting case, the display 
is showing a 98% probability that the starting contrast will be somewhere 
between 0.93 and 99.00. As this is almost the entire probability range of 0-
100 at this point, it is a fairly safe bet given that no test has yet been made.  

With the operator pressing the yes/no keys in response to the patient’s 
affirmative or negative replies, the test will proceed until the 1% to 99% 
boundaries contain less than 5% of the initial possible range of 0-100. At 
this point the test ends with the handheld emitting three short beeps and 
displaying a final screen similar to this: 

 

The Letter is the final displayed letter, and the Contrast is the final contrast 
threshold level – i.e. the test result. Recall that this is a dimensionless 
number that has considerable dependency on the setup of your monitor and 
lighting conditions. The False Negatives show the number of false 
negative responses by the patient on the left compared to the number of 
false negative presentations on the right. The 1% and 99% figures define 
the boundaries of a range of contrast figures within which the final figure 
could appear with a 98% probability. The test result can be anywhere 
between these boundaries. The smaller this range the higher the confidence 
that can be placed in the final figure. 
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Acuity Staircase Test 
The Acuity Staircase test displays a single letter from the standard 
optotype selection, with or without I-bars, and at an operator selectable 
contrast. Optionally the letter can be displayed for a set time with the 
shortest display time being 50 milliseconds and increasing in 50 
millisecond steps to 2000 milliseconds. 

The letter is presented to the patient either momentarily or continuously 
and he or she is asked whether they recognise the letter. The letter and its 
current Snellen fraction are displayed on the handheld screen along with 
some statistical data. If the patient recognises the letter correctly the 
operator swipes Right, if not then swipe Left. Based on this response the 
software will adjust the size and present a different letter at that new size. 

Performing the Test 
The initial screen allows a pre-test setup. Entries are included for: 

Optotype 
Contrast 
Timed Exposure 
Exposure time (in mSec) 
I-Bars 

The Optotype selection is the standard set, although as the patient must 
“recognise” the letter, perhaps only a subset of the types are applicable. 
The Timed Exposure is either on or off. The Contrast and I-bars may be set 
as desired for the intent of the test. The initial patient screen is a single 
letter and the handheld display presents the initial test state below. 

 

The Letter is the letter displayed to the patient. The Snellen fraction 
(Acuity) will be the size of that initial letter. The 1% and 99% Levels 
define the probability boundaries such that 1% of the population is 
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Acuity Staircase Test 

expected to be below the 1% figure, and another 1% above the 99% figure. 
Of course this means that 98% of the population is expected to be between 
these boundaries. In this starting case, the display is showing a 98% 
probability that the starting contrast will be somewhere between the ratios 
of 6/3.12 and 6/116.23. As this is almost the entire probability range at this 
point, it is a fairly safe bet given that no test has yet been made.  

With the operator pressing the yes/no keys in response to the patient’s 
affirmative or negative replies, the test will proceed until the 1% to 99% 
boundaries contain less than 5% of the initial range. At this point the test 
ends with the handheld emitting three short beeps and displaying a final 
screen similar to this: 

 

The Letter is the final seen letter. The Acuity figure is the final Snellen 
fraction – the test result. The 1% and 99% figures define the boundaries of 
a range of Snellen fractions within which the final figure could appear with 
a 98% probability. The test result can be anywhere between these 
boundaries. The smaller this range the higher the confidence that can be 
placed in the final figure. 

 Medmont Acuity Tester User Manual 56



 Charts 

Charts 
The Chart display function of the AT-20P is a very useful patient 
information and education aid. While the software is shipped with a 
limited number of sample charts, you can easily customise the system to 
add your own digital images, charts, animations or movies. 

Required Chart Format 
Images (charts) can be Jpeg, Bitmaps, AVIs or MPEGs, having filename 
extensions of JPG, BMP, AVI or MPG respectively. The resolution 
(number of pixels in the horizontal and vertical dimensions) is not critical, 
as the image is automatically increased or decreased in size to fit the 
patient’s display screen resolution while retaining the original aspect ratio. 
However, images much lower in resolution that the patient display screen 
will show pixilation artefacts due to the large zoom necessary, and there is 
a time-to-display penalty for images much larger than the display 
resolution. 

Note that Charts are like any other part of the AT-20P repertoire, and so a 
particular chart can be the default patient display when the system starts. 
This could be the practise logo for instance. The technique is to select and 
display the required chart, then make that the default startup using the 
steps described in the Save Current Settings as Startup section on page 25. 

Adding and Deleting User Charts 
You add your own charts from the AT-20P control dialog. There is no real 
limit to the number of charts. With the software running, click on the AT-
20P icon in the Windows task bar. When the dialog appears, click on the 
Charts tab to display this dialog. 
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Charts 

 

From here you can add and remove charts and/or edit a particular entry. As 
an example of the necessary steps, we will add a sample image. First click 
on the Add button to bring up the Add/Edit Chart dialog. 

 

Click on the Browse button to navigate to the folder where your new 
image is stored (the default images are in the installation directory, 
typically C:\Program Files\Medmont\AT-20P). Click on the image file to 
select it and then click the Open button. You must now enter a name for 
this image that will be the name presented on the handheld display. The 
dialog shown below shows a file selected and named “Lake”. 

 

Click the OK button and you will see the Charts dialog with the new entry 
added and a thumbnail view of your selected image. 
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 Charts 

 

If you click on OK here and then select Charts on the handheld you will 
see the new image included in the menu charts list. You can now select 
and display this chart just like the Medmont supplied charts. 

To remove a particular chart, click to select it in the chart list and then 
click on the Remove button, Note that this simply removes the image from 
the AT-20P charts list. The image on disk is untouched. 
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Fixation Targets 
The fixation targets provide a point of reference to which the patient can 
be directed to fixate. A snapshot of each is shown below. 

 

 

 

 
 

From left to right and top to bottom, the fixation target names are: 

 
Dot Point of Light Clock 

Robot Butterfly Bear 

Frog Cops & Robbers Dragon

Puppy Piano  
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 Fixation Targets 

All except the Dot are animated. The Point of Light simply cycles through 
a set of colours. The rest are animations primarily aimed at maintaining 
fixation for children and similar patients. They last for just a dozen or so 
seconds and then automatically repeat. Some include appropriate audio.  

Adding and Deleting Fixations 
You can add your own fixation animations or images from the AT-20P 
control dialog. There is no real limit to the number of animations. With the 
software running, click on the AT-20P icon in the Windows task bar. 
When the dialog appears, click on the Fixation Targets tab to display this 
dialog. 

 

Selecting any fixation will play it once in the Preview window. It also adds 
a Play button that can be used to subsequently replay the fixation. 
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Fixation Targets 

 

From here you can add and remove charts and/or edit a particular entry.  

 

You can add a new image or animation or movie of your own. Click on the 
Add then Browse button to navigate to the folder where your new image is 
stored (the default images are in the installation directory, typically 
C:\Program Files\Medmont\AT-20P). After you have made the selection it 
will be available for display in addition to the default images. 

Auto Display 
If you are displaying a fixation target and you press the Options key, one 
of the options is called Auto Display. If you select this the system will 
play each fixation target once, then move on to the next in a continuous 
loop. If you click on the Edit button to bring up the Add/Edit Fixation 
Target dialog, you will notice a check box called Auto Display. You can 
use the Auto Display check box in this dialog to select whether that 
particular target will be included in the display sequence.  

Whether a target is included or not in this list is shown in the Auto Display 
column of the main dialog above. 
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Excluded Words 
The letters available for the various acuity tests can optionally be selected 
and arranged randomly (see Random Key found on page 24). There are 
enough letters available to form words that may be insulting, 
objectionable, or simply surprising to some patients in both English and 
other languages. The system settings file includes a section called 
ExcludedWords where Medmont has already added a number of possibly 
objectionable letter combinations. This file is an XML text file that can be 
edited using a Windows text editor such as Notepad. 

Only the first dozen or so lines deal with excluded words. Do 
not edit any other section of this file. It is very important when 
editing this file to exactly match the existing syntax. 

The relevant section is at the start of the file. At the time of writing, the 
first dozen or so lines are as displayed below. 

<?xml version="1.0" encoding="UTF-16" standalone="yes" ?> 
<AT200SystemSettings> 
 <ExcludedWords> 
 <ExcludedWord>FART</ExcludedWord> 
 <ExcludedWord>PORN</ExcludedWord> 
 <ExcludedWord>DEAF</ExcludedWord> 
 <ExcludedWord>TURD</ExcludedWord> 
 <ExcludedWord>FU</ExcludedWord> 
 <ExcludedWord>VD</ExcludedWord> 
 <ExcludedWord>DEATH</ExcludedWord> 
 <ExcludedWord>COK</ExcludedWord> 
 <ExcludedWord>CODS</ExcludedWord> 
 <ExcludedWord>SOD</ExcludedWord> 
 <ExcludedWord>DORK</ExcludedWord> 
 </ExcludedWords> 
 <Optotypes> 
  <Optotype> 
   <Name>Snellen</Name> 
   <Font>Snellen.ttf</Font> 
   <Characters>ADEFHNOPRTUVXZ</Characters> 
   . 

As an example, we will add the word “POT”, which may be a source of 
great amusement to boys of a certain age. Start Notepad, click on File and 
Open, select Files of Type: All Files, then navigate to and load the file: 
 C:\Program Files\Medmont\AT20P\SystemSettings.xml 

Position the cursor at the first entry in the ExcludedWords list and enter 
the new excluded word bracketed by the XML tag words: 
 <ExcludedWords> 
  <ExcludedWord>POT</ExcludedWord> 
  <ExcludedWord>FART</ExcludedWord> 

Click on File and then Save. This new word will now be excluded from all 
possible letter combinations. 
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Setting Test Colours for Duo-Chrome and Duo-
Chrome Acuity Tests 

The tests called Duo-Chrome and Duo-Chrome Acuity uses colours as 
part of their capabilities. You can choose to alter the default colours to a 
colour selection of your own. 

With the AT-20P application running and a connection to the handheld 
made, click on the AT-20P icon  in the task bar. Click on the Colours 
tab to show the following dialog. 

 

Click on the drop down arrow for Colour 1 or Colour 2 to access the 
Colour menu for that selection: 

 Medmont Acuity Tester User Manual 64



 Setting Test Colours for Duo-Chrome and Duo-Chrome Acuity Tests 

 

 

Before you change the colour, click on the Add to Custom Colours 
button to save the current colour in case you later wish to restore it. As 
shown here, the current colour is then copied to the next available Custom 
Colours box. 

You can now select a new colour from either the Basic Colours set, click 
and drag in the palette and/or intensity controls, or specify a particular 
HSL or RGB combination. Clicking on OK will select that colour. This 
will be saved and henceforth become the default colour for this part of that 
test. 
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Specifications 
Model AT-20P 

Tests Acuity Charts 
 LogMAR 
 US Snellen 
 UK Snellen 
 EU Snellen 
 ETDRS 
Cross Cylinder 
Duo-Chrome 
Duo-Chrome Acuity 
Fogging 
Binocular Disparity 
Binocular Acuity 
Worth Four 
Gratings 
Contrast Threshold 
Acuity Staircase 
Charts 
Fixation Targets 

Remote Control Wi-Fi 
Spread Spectrum 2.4 GHz ISM 

Remote range 100 m 
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 Specifications 

Recommended System 
Requirements 

 

• Pentium™ processor-based personal 
computer, P4 2.8 GHz or Higher (P4 
1GHz minimum). Motherboard using 
genuine Intel™ PCI chipset highly 
recommended. VIA chipsets have 
proven to be unreliable. 

• Microsoft™ Windows™ 7 32 or 
64bit.  

• 4 GB RAM or more (2 GB minimum)  
• VGA card supporting at least 24-bit 

colour and 128MB onboard memory. 
Video cards that share main memory 
are not recommended. Compatible 
NVidia card required for binocular 
testing using NVidia stereo driver. 

• 10GB of available hard-disk space 
• DVD-ROM drive (CD-ROM 

minimum) 

Monitor requirements Min 800x600 resolution 

Flipper Red / Blue discrimination 

Product life 4 years 
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Declaration of Conformity 
The Medmont Acuity Tester  

 Model AT-20P  

has been manufactured by 

Medmont Pty Ltd 
Unit 1, Whitehorse Business Park 
170-180 Rooks Rd  
Vermont, 3133, Australia 

It has been classified as a Class I Medical Device and is in conformity with 
the essential requirements and provisions of the European Council 
Directive 93/42 EEC. 

It is in compliance with the standards 

IEC 62304:2006-05 Medical Device Software – Software life 
cycle processes. 

As identification of its conformity, the Medmont AT-20P is labelled with 
the CE mark (as shown below) in the About box of the PC Software. 

 

 

 

Authorised EU representative: 
 
BiB Ophthalmic Instruments 
Unit 8, The Orbital Centre, Cockerel Close 
Gunnels Wood Road 
Stevenage, Hertfordshire SG1 2NB 
England 
Tel: 0044 (0)1438 740823 
Fax: 0044 (0)1438 356093 
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Representatives 
 

Your Local Medmont Authorised Agent Is: 
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